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1.1 Purpose 

This manual describes how to use the Intel Client tool.  The purpose of the Intel Client tool is to 
assist you with intelligence collection, analysis, processing, and dissemination.  The Intel Client 
tool is explained in detail in the main sections of this manual.  Information regarding the set-up 
and maintenance of the Intel Client can be found in the appendixes.  This manual’s sections and 
appendixes are as follows: 

• Section 1, Introduction, contains overviews of the Intel Client tool, the structure of 
intelligence data, and acquiring intelligence data. 

• Section 2, Loading an IDMS Workstation with Intel Data, contains procedures for 
loading an Intel/Ops workstation with intelligence data.  

• Section 3, Adding and Modifying Intelligence Data, contains procedures on how to 
use Intel Update to add, modify, and delete intelligence data. 

• Section 4, Accessing Intelligence Data, contains procedures on how to create and run 
queries using Intel Query and Land Track Query.   

• Section 5, Viewing Intelligence Data, contains procedures on how to view reports of 
intelligence data and how to use Intel Filters to choose which types of intelligence 
data you want to view. 

• Section 6, Disseminating Data, contains procedures on how to print out reports of 
intelligence data. 

• Appendix A, Acronyms, contains a list of acronyms found in this manual. 

• Appendix B, Intelligence Field Reference, contains a list of fields used by intelligence 
data. 

• Appendix C, Query Reference, contains information and examples on simple and 
compound queries. 

Table 1-1 lists the conventions used in this manual. 

Table 1-1.  Conventions Used in This Manual 

Convention Circumstance 

bold check box, command button, drop-down menu, group box, menu item, 
option button, submenu, tab, text box 

BOLDCAPS keyboard key 

bold italic emphasis 

Courier directory name, file name 

italic document title 
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1.2 Referenced Documents 

This manual references the following documents.   

Intel Client Installation Procedures, version 1.0, dated 19 July 1999, Litton PRC. 

Intel Client Intelligence Functional Area (IFA) Reference, version 1.0, dated 19 July 1999, 
Litton PRC. 

1.3 System Overview 

The Intel Client tool allows you to receive, manage, validate, analyze, and disseminate 
intelligence data.  The Intel Client tool contains specific intelligence attributes for non-U.S. 
Units, Facilities, Equipment, Individuals, and Unknown entities.  The Intel Client tool assists you 
with fusing all source tactical information and intelligence into a coherent view of the threat 
picture.  The Intel Client tool is designed to be installed on an Intel/Ops workstation, running the 
Microsoft Windows NT operating system and Command and Control PC (C2PC). 

The objective of the Intel Client tool is to support you in creating and disseminating the current 
intelligence picture to a commander, the commander’s staff, and supported units.  The key task 
in creating an accurate threat picture is creating and maintaining a Local View. 

The Intel/Ops workstation (IOW) is first loaded with National data.  National data is finished 
intelligence from national intelligence agencies.  During an operation, Tactical data will be 
added through reports and messages from aircraft, satellites, and other units.  As you analyze and 
validate Tactical data, you will be updating your Local View.  The Local View is the centerpiece 
of the Current Intelligence Situation (CIS).  After the Local View is updated, the CIS must be 
disseminated in a meaningful way.  You disseminate the CIS by using customized reports, briefs 
and by injecting tracks into the Common Operational Picture (COP) (see Section 6, 
Disseminating Data, for more information on printing reports).    

The Intel Client tool stores intelligence data in a MIDB 2.0 database.  When you load the Intel 
Client with National data, you will only load a subset of data that pertains to your current Area of 
Responsibility (AOR) (see Section 2, Loading an IDMS Workstation with Intel Data, for more 
information on loading data).  The stored data on your workstation is determined by your needs, 
allowing you to work relatively independently of other computer systems or servers. 

The following sections provide more detail on the different types and sources of intelligence 
data. 

1.4 Structure of Intelligence Data 

Intelligence data is stored on an Intelligence Shared Data Server (ISDS).  One or more 
commands within the Marine Air Ground Task Force (MAGTF) will maintain an ISDS.  This 
ISDS will act as the single central source for all intelligence data.  When you initially load the 
database on your Intel/Ops workstation, you will be pulling data from this ISDS. 
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Key Term: ISDS 
Stores intelligence data from multiple sources.  National, Tactical, and Local data are all stored 
on an ISDS.  

Throughout an operation, Tactical data will be added to your database through messages and 
voice reports.  You might also add Tactical data from the ISDS.  Tactical data is reported data 
that has not yet been analyzed and validated.  After performing the necessary review and 
analysis, a valid tactical record can be promoted to the Local View.  The Local View contains 
National data as a foundation, along with promoted Tactical data.  The following sections go into 
more detail about each type of data. 

1.4.1 National Data 

National data is finished data that has been analyzed, validated, and released by National 
Intelligence Agencies.  This data consists of facility, unit, equipment, and related data.  Only a 
designated National Intelligence Producer can update National data.  Only National data will 
exist in your database when you initially load your workstation.  When loading your workstation, 
only a subset of National data is needed.  You decide which parts of National data are required 
for a particular operation.  For example, if you were on an operation in Southeast Asia, you 
might not load data from South America.  See Section 2, Loading an IDMS Workstation with 
Intel Data, for information on how to load a subset of National data. 

Updates to National data are made weekly.  Tactical operations rely on accurate updated data, 
which can change day to day or even hour to hour.  Weekly National updates are normally 
insufficient for tactical operations.  Local analysis based on tactical reporting is normally the 
most timely source of intelligence for a command.  The CIS or Local View represents a 
command’s local analysis of the combination of National and Tactical data. 

1.4.2 Tactical Data 

Tactical data is data that has been reported in near real-time (NRT), but has not been reviewed.  
Tactical data can be classified as organic and non-organic data.  Organic data includes sensor 
data and recon reports.  Non-organic data is typically data received in USMTF messages.  
Imagery Interpretation Reports (IIRs) from TARPS missions and Recognizance Exploitation 
Reports (RECCEXREPs) from UAV missions are examples of non-organic reporting. 

Tactical data originates from messages and reports.  If the message or report correlates with data 
already stored in the database, the information is associated with the existing data.  Tactical data 
can also be entered manually into your IOW.  Tactical data loaded from an ISDS will still require 
review. 

It is your responsibility to review Tactical data as necessary.  Once reviewed, valid Tactical data 
is promoted to the Local View.  Use the Intel Update tool to promote Tactical data (see Section 
2, Loading an IDMS Workstation with Intel Data, for more information).   
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1.4.3 Local View 

The Local View is made up of both National data and promoted Tactical data.  The Local View 
provides you with the most accurate CIS.  The CIS describes what is occurring in your Area of 
Responsibility (AOR).  

The Local View is the common view of the threat picture for your command.  It is important that 
this view is current and accurate so that the commander and staff can effectively make decisions 
based on this information.  As the analyst, you are responsible for providing your commander, 
the commander’s staff, and supporting units with timely, analyzed data.  Therefore, it is critical 
that Tactical data is reviewed as often as possible, and that the Local View is maintained. 

If you do not maintain the Local View, your CIS will consist primarily of National data.  Relying 
on National data only gives a commander a partial picture of the threat.  Failing to update the 
CIS will not provide the most accurate intelligence data.  

1.5 Categories of Intelligence Data 

Intelligence data is divided up into categories called Intelligence Functional Areas (IFAs).  IFAs 
are functional groupings of intelligence data.  For example, all data related to medical units and 
facilities is grouped into one category, while all Ground Order of Battle (GOB) units, facilities, 
and equipment data is grouped into the GOB IFA.   

IFAs are an important part of the Intel Client tool.  You will use IFAs for operations such as 
producing intelligence reports, adding records, and plotting tracks.   

IFAs are organized into levels.  There are 13 top level IFAs (see Figure 1-1).   

 

Figure 1-1.  Top Level IFAs 

Each top level IFA can contain one or more sub-levels below it.  As you move down a level, the 
categories represent more specific groupings of data.  For example, see Figure 1-2 for the 
Command, Control, Communications, Computers and Intelligence (C4I) IFA.   
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Figure 1-2.  C4I Structure 

This diagram shows three levels of the C4I IFA.  A shaded box indicates that the IFA can also be 
found in a different part of the IFA structure.  For example, the GHDQ IFA can also be found 
under the GOB IFA. 

NOTE: The C4I IFA actually contains more than three levels.  To conserve space and improve 
clarity, only three levels are displayed.   

The top level is the most general grouping of C4I data.  Below the top level are 4 sub-level 
categories; each category represents more specific C4I groupings.  For example, communications 
(COM), headquarters (HDQ), intelligence (INT), computers (COMP), and communications 
equipment (COMQ) are all types of C4I data.   

The relationship between levels can be explained as follows:  Ground headquarters (GHDQ) is a 
type of headquarters (HDQ).  HDQ is a type of command, control, communications, computers, 
and intelligence (C4I) data.   

IFA groupings can represent Units, Facilities, or Equipment.  In the C4I example, COM 
represents both Units and Facilities, while COMQ only represents Equipment.   

The Intel Client Intelligence Functional Area (IFA) Reference document, as referenced in 
Section 1.2, Referenced Documents, contains a complete listing and description of the IFAs. 

1.6 Acquiring Intelligence Data 

There are multiple ways to acquire intelligence data.  Initially, there will be no intelligence data 
in your Intel Client workstation.  You must load your workstation with data acquired from an 
ISDS.  After your workstation is initially loaded with data, you will acquire intelligence data 
through voice and unformatted reports.  Lastly, you can acquire data from a Track Database 
Manager (TDBM). 
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NOTE: A workstation that is loaded with data from an ISDS is called an Intelligence Data 
Management Services (IDMS) workstation.  Once a workstation is configured as an 
IDMS, other workstations can connect to the IDMS and view and update the data stored 
there.  See the Intel Client Installation Procedures document as referenced in Section 
1.2, Referenced Documents, for information on configuring a workstation. 

The following sections contain a diagram, overview, and a description of the Intel Client tools 
that are used for each method of acquiring intelligence data. 

1.6.1 Intelligence Data from an ISDS 

Prior to the start of an operation, your workstation will not contain any intelligence data, so 
intelligence data from an ISDS is needed to load your workstation.  Your Standard Operating 
Procedures (SOPs) will specify which ISDS you will use to load your workstation. 

Figure 1-3 shows a combination of National and Local data being sent from an ISDS to your 
local workstation.  The data from an ISDS is then stored on your local workstation. 

 

Figure 1-3.  Intelligence Data from an ISDS 

The GMI Import/Export Utility tool is used to acquire data from an ISDS (see Section 2, 
Introduction, for procedures on how to use the GMI Import/Export Utility tool). 
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1.6.2 Intelligence Data from Reports 

During the course of your mission, you will receive intelligence data from sightings and 
observations in the form of voice and unformatted reports (also know as Tactical data).  When 
you receive reports, you will need to manually update your workstation’s data.  You will be 
maintaining your Local View as you enter in the updates received from these tactical reports. 

Figure 1-4 shows voice and unformatted reports being received from various sources.  The data 
is analyzed and updated manually.  The Local View reflects the updates made. 

 

Figure 1-4.  Intelligence Data from Reports 

The Intel Update tool is used to enter data from reports (see Section 3, Adding and Modifying 
Intelligence Data, for an explanation of the Intel Update tool). 
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1.6.3 Intelligence Data from TDBM 

The Track Database Manager (TDBM) stores tracks containing information on items such as 
airplanes, ships, and facilities.  The TDBM “pushes” its data so that anyone connected will 
automatically receive updates.   

Figure 1-5 shows data being pushed from the TDBM to the C2PC gateway.  From the C2PC 
gateway, the data is sent to the C2PC Track database located on your workstation.  The tracks in 
the C2PC Track database are compared to data in the Local View.  If there is an association 
between the two, the data is linked, and only one track is displayed on your map. 

 

Figure 1-5.  Intelligence Data from TDBM 

The Track Association Tool will provide this capability and will be included with a future 
version of C2PC. 
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1.6.4 Overall Picture 

Figure 1-6 shows all three methods for acquiring intelligence data: 

 

Figure 1-6.  Methods for Acquiring Intelligence Data 



Intel Client User Manual 

July 1999  1-11 

1.7 Summary of Intelligence Data 

Figure 1-7 summarizes the information from the last three sections and provides an overall view 
of how the Intel Client inter-operates with other MAGTF C4I Intelligence Systems. 

 

Figure 1-7.  Intelligence Data Summary Diagram 

The diagram above shows how you interact with other intelligence providers.  At the top level is 
the MAGTF IAS, which uses an ISDS to manage its intelligence data.  The ISDS maintains a 
Local View by analyzing National and Tactical data.   

Your Local View will initially be built from loading data from an IAS ISDS.  During your 
mission you will receive reports from various sources.  Examples of intelligence sources are 
shown at the bottom of Figure 1-7.  These reports will be entered into your workstation as 
Tactical data.  You will use the Intel Client tools to analyze and promote Tactical data to your 
Local View.   

You can also send your intelligence data back up to the MAGTF IAS.  Your intelligence data 
will be stored as Tactical data in the ISDS.  It will be reviewed and fused with other sources of 
Tactical data to create the MAGTFs Command Element’s Local View. 

This chapter covered how intelligence data is structured and categorized.  This chapter also 
provided an overview of the purpose and features of the Intel Client tool.  The following chapters 
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give detailed procedures on how to perform data analysis, dissemination, and collection using the 
Intel Client tool. 
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The Intel Client supports independent field operations.  Prior to an operation, you download the 
required National and Local data from the supporting Intelligence Analyst Station (IAS).  While 
in the field, you maintain your own Local View of the threat.  Once connection is re-established 
with the MEF, updates are exchanged.  

Use the GMI Import/Export Utility tool to load your local workstation with a specified subset of 
intelligence data.  You can specify the source and allegiance of the data you load.   

The purpose of loading a subset of data is to only load information that is needed for your current 
mission.  Rather than cluttering your map with data from each country in the world, you can load 
data that only pertains to your current mission. 

WARNING: Loading an IDMS workstation will remove all existing intelligence data from the 
Intel Client tool.   

A network connection is recommended when using the GMI Import/Export Utility.  If you do not 
have access to a network connection, the GMI Import/Export Utility can still be used to load 
your workstation, but you will need access to BCP files (see Section 2.2, Acquiring BCP Files, 
for more information). 

2.1 Deleting Existing Data 

Before any data can be loaded onto your workstation, all existing data must be removed. 
Intelligence data is stored in BCP files.   BCP files are tab delimited text files.  All of the 
intelligence data currently on your workstation is stored in BCP files.   

WARNING: Completing the steps in this section will result in all current intelligence data being 
deleted from your workstation. 

➜ To delete existing data: 

NOTE: If your workstation has never been loaded with data, there will not be any BCP files 
located on your workstation.  You can skip directly to the next section (Section 2.2, 
Acquiring BCP Files).   

Step 1. Log in to the workstation as an administrator. 

Step 2. Go to the Start menu, choose Programs, choose GMI, and select GMI Import 
& Export Utility. 

The GMI Import & Export Utility window appears (see Figure 2-1). 
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Figure 2-1.  GMI Import/Export Utility (Export View) 

Step 3. Go to the Path box, and write down the directory path stored there.   

This directory path shows what folder the current BCP files are stored in (the 
default path is C:\Program Files\Intel Client\data\). 

Step 4. Go to the Windows desktop, and open up the folder containing the BCP files. 

Step 5. Delete all of the BCP files from the folder. 

Once all of the BCP files are deleted, you can acquire new BCP files (see Section 2.2, Acquiring 
BCP Files). 

2.2 Acquiring BCP Files 

The second step in performing a base load is acquiring BCP files.  BCP files are created when 
data is exported from one computer system to a workstation.  The GMI Import/Export Utility 
requires a network connection to export data from an ISDS or IDMS.  

BCP files can still be transferred between workstations, if your workstation does not have access 
to a network.   

If you have a network connection, see Section 2.2.1, Acquiring BCP Files with a Network 
Connection.  

If you do not have a network connection, see Section 2.2.2, Acquiring BCP Files without a 
Network Connection. 
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2.2.1 Acquiring BCP Files with a Network Connection 

You select the source and allegiance of the intelligence data you want to load.  The data is 
exported to your workstation as BCP files.   

➜ To export BCP files: 

Step 1. Log in to the workstation as an administrator. 

Step 2. Go to the Start menu, choose Programs, choose GMI, and select GMI Import 
& Export Utility. 

The main window of the GMI Import/Export Utility appears (see Figure 2-1) 

Step 3. Click the Export tab. 

Step 4. Go to the Export Data Source box, and select where you want to get your data 
from. 

In most cases, the data source will be an ISDS approved by your commander. 

Step 5. Go to the Flag box, and select the type of data you want to load.   

Step 6. Click Apply.   

A status bar appears, and data is loaded on to your workstation.  

Step 7. If you want to export data from multiple countries, select the next country, and 
click Apply. 

Repeat Step 7 until you are finished selecting countries to load from. 

Once the load is complete, all of the data will be stored in BCP files located in the location you 
specified (the default location is C:\Program Files\Intel Client\data\).  You will 
not be able to access the data until you import it into the Intel Client tool (see Section 2.3, 
Importing Data). 

2.2.2 Acquiring BCP Files without a Network Connection 

When no network connection is available, BCP files are acquired from CD-ROM, floppy disks, 
Zip disks, rather than an export from an ISDS.  BCP files can be copied to any type of portable 
storage medium (for example, CD-ROM, floppy disk, or Zip disk).  The BCP files are then 
copied from the medium to your local workstation.   

You must have access to a CD-ROM, floppy disk, or Zip disk that contains BCP files. 
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➜ To copy BCP files to your local workstation: 

Step 1. Insert the CD-ROM, floppy disk, or Zip disk containing BCP files. 

Step 2. Go to the Windows desktop, and open up the BCP disk. 

Step 3. Copy all of the BCP files from the disk. 

Step 4. Paste the BCP files into a folder on your workstation. 

It is recommended that you paste the BCP files into the following folder: 

C:\Program Files\Intel Client\data\ 

Your workstation now contains BCP files.  You will not be able to access the data in the BCP 
files until you import it into the Intel Client tool (see Section 2.3, Importing Data). 

2.3 Importing Data 

The last step in performing a base load is importing data.  To import data, you must have access 
to BCP files.  Once the BCP files are imported to your workstation, you will be able to access the 
data using the Intel Client tool. 

➜ To import data: 

Step 1. Log in to the workstation as an administrator. 

Step 2. Go to the Start menu, choose Programs, choose GMI, and select GMI Import 
& Export Utility. 

The main window of the base load tool appears (see Figure 2-1) 

Step 3. Click the Import tab. 

The Import view appears (see Figure 2-2). 
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Figure 2-2.  GMI Import/Export Utility (Import View) 

Step 4. Go to the Import Data Source box, and select what workstation you want to load 
imported data into.   

In most cases you will select your IDMS. 

Step 5. If you have moved the BCP files, click Browse to select the location of the 
exported data.  Otherwise, continue to Step 5. 

Step 6. Click OK to import the data into the Intel Client tool. 

A status bar appears, and data will be imported from the BCP files into the Intel 
Client tool.   

Once the import is complete, you will able to view, modify, and disseminate the 
data using the Intel Client tool. 
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Intel Update is used to add, modify, and delete intelligence data.  Once added, a Facility or Unit 
record is displayed on the map as a track.   

Key Term: Track 
A track is a symbol representing a Facility or Unit.  

The Facility or Unit’s data (location, allegiance, functional area, etc.) is called a report.  You can 
use Intel Update to add, modify, or delete the values of a Facility or Unit.  Additionally, you can 
enter remarks for the specified Facility or Unit. 

3.1 Overview of the Intel Update Window 

It is important to be familiar with Intel Update’s features before adding, modifying, or deleting 
Facilities or Units.   

There are two ways to open the Intel Update main window from the C2PC application: from the 
Insert menu and from the TrackPlot menu. 

➜ To open Intel Update from the Insert menu: 

Step 1. Go to the Insert menu, and select Track. 

The Insert Track window appears asking you to select either a Facility or Unit to 
add. 

Step 2. Select either a Facility or Unit to add. 

Step 3. Click OK. 

The Intel Update (see Figure 3-1) window opens. 

➜ To open Intel Update from the TrackPlot menu: 

• Go to the TrackPlot menu, and select Intel Update. 

The Intel Update (see Figure 3-1) window opens.   

All Intel Update functions are accessed through one main window (see Figure 3-1).   
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Figure 3-1.  Sample Main Intel Update Window 

3.1.1 Menu Bar 

You can access functions from the menu bar, including Save, Delete, and Help. 

3.1.2 Toolbar 

Like the menu bar, the toolbar provides access to the most commonly used functions.  Toolbar 
functions are accessed by clicking a button rather than choosing a menu item.  Some functions, 
such as Save and Open, are available both through the menu and toolbar.  Other functions are 
only available through either the menu or the toolbar. 

Table 3-1 lists important toolbar buttons. 

Table 3-1.  Intel Update Toolbar 

Button Name Function 

 
New Facility Adds a new Facility.  

 
New Unit Adds a new Unit. 

 
Save Saves a report to the Local View.  See 

Section 3.3, Saving a New Facility or Unit, 
for more information. 
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Button Name Function 

 
Delete Deletes a report from the Local View.  See 

Section 3.6, Deleting a Facility or Unit , for 
more information. 

 
Create local record Copies a National data record to the Local 

View.  See Section 3.9, Modifying 
National Data to the Local , for more 
information. 

 
Report Displays a Land Track report on the 

selected track.  See Section 5, Viewing 
Intelligence Data, for more information. 

 
Previous and Next Switch between multiple reports.  Click the 

right arrow to view the next report.  Click 
the left arrow to view the previous report. 

 
Help Accesses online help. 

3.1.3 Tabs 

The two allow you to toggle between different views of the Intel Update window.  The default 
view is a Facility or Unit’s attributes.  This view is used to enter the majority of Facility and Unit 
information.  Click the Remarks tab to enter text comments about a Facility or Unit (see Section 
3.2, Adding New Facilities or Units).   

3.1.4 Fields 

The main portion of the Intel Update window shows the available fields for either a Facility or 
Unit.  Facilities and Units have separate sets of fields.  Each field contains a box where values 
are entered or selected (see Appendix C, Unit and Facility Field Reference, for a definition of 
Facility and Unit fields). 

3.1.5 Location Selector  

Click the Location Selector to get a location from the active map.  Rather than typing location 
coordinates, you can use the Location Selector to enter coordinates by clicking on the desired 
location on the map.  

➜ To use Location Selector: 

Step 1. Click the Location Selector. 

The cursor turns into a cross-hair. 
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Step 2. Move the cross-hair to the location on the map you want the coordinates for and 
click. 

The location coordinates for the selected point on the map are entered into the 
Location box for you.   

3.1.6 Functional Area Selector 

Click the Functional Area Selector to select an Intel Functional Area (IFA) for the Facility or 
Unit.  Rather than typing in an IFA name, you can select a name from a menu of options (see 
Section 1.5, Categories of Intelligence Data, for more information on IFAs). 

➜ To use the Functional Area Selector: 

Step 1. Click the Functional Selector Area button. 

The Intel Functional Areas window appears (see Figure 3-2). 

 

Figure 3-2.  Intel Functional Areas 

The left side of the Intel Functional Areas window contains a listing of IFAs.  
IFAs are arranged in a “tree” structure.  A tree structure means that the list starts 
out at the root level and branches out to more specific IFA categories.  The IFA 
list expands and shrinks according to the current level of detail.   

When a listing can be expanded to more specific IFA categories, there will be a 
plus (+) in the box before it.  The + box can be selected to display more specific 
IFA categories.  Once a + box is selected, a list of more specific IFAs is 
displayed.  The box’s plus sign will be replaced with a minus (-) sign.   

The following example illustrates a possible IFA selection for a Unit: 

Ground Order of Battle ➔  Infantry ➔  Foot Infantry ➔  Ground Combat, Infantry 
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Step 2. Highlight the IFA name you want to select. 

Step 3. Click OK.   

The Intel Functional Area window closes, and the selected IFA name is displayed 
in the Functional Area field. 

NOTE: Intel Update restricts the IFAs you can choose depending if you are adding a Facility or 
Unit.  For example, you will not be able to assign a Unit IFA to a Facility report. 

3.2 Adding New Facilities or Units 

Adding new Facility or Unit reports updates your selected database with new intelligence data.  
Any additions, modifications, or deletions made using Intel Update will be saved as part of your 
Local View. 

NOTE: You must have an understanding of the Facility and Unit fields to properly add a new 
report (see Appendix B, Unit and Facility Field Reference). 

Before using Intel Update, make sure that C2PC is running and you have a map displayed on 
your screen.   

➜ To add a new Facility or Unit: 

Step 1. Go to the TrackPlot menu, and select Intel Update.   

The Intel Update window appears (see Figure 3-3). 
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Figure 3-3.  Intel Update  

Each field in the window is filled with a default value (for information on 
changing the default values, see Section 3.8, Modifying Default Values). 

Step 2. Select either a Facility or Unit to add: 

• To add a Facility, click the New Facility button on the toolbar.   

• To add a Unit, click the New Unit button. 

Step 3. Click in the fields you want to modify.   

The cursor appears in the field, and the entire field is outlined in red.   

Step 4. Modify the fields as follows:   

• If you are entering data in the Location field, type a coordinate or see Section 
3.1.5, Location Selector, for information on using the Location Selector. 

• If you are entering data in the Functional Area field, see Section 3.1.6, 
Functional Area Selector, for information on using the Functional Area 
Selector. 

• If you are entering data in any other fields, type or select a value from a list. 
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Step 5. (Optional) To enter in remarks and comments about the facility, click the 
Remarks tab.   

The Remarks view appears (see Figure 3-4). 

 

Figure 3-4.  Remarks View 

Type your comments for the Facility or Unit report. 

Step 6. When you are done adding data to the fields, go to Section 3.3, Saving a New 
Facility or Unit, to save the report. 

3.3 Saving a New Facility or Unit 

After you have finished entering values for a new Facility or Unit report, save the report to add it 
to your Local View.   

➜ To save a Facility or Unit: 

Step 1. In the Intel Update window, go to the File menu, and select Save; or click the 
Save button on the toolbar (see Table 3-1).   

A dialog box appears notifying you that the Facility or Unit was successfully 
added (see Figure 3-5). 
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Figure 3-5.  Save Confirmation 

The track is added to your Local View. 

Step 2. Click OK to close the confirmation dialog box. 

3.4 Selecting Tracks 

Selecting tracks is used to modify and delete Facilities and Units.  Intel Update allows you to 
select a single track or multiple tracks at once. 

➜ To select a single track: 

Step 1. Click the track you want to modify on the map or the track plot tree (located to 
the left of the map). 

The selected track is highlighted. 

Step 2. Go to the TrackPlot menu, and select Intel Update. 

The Intel Update window appears with data from the selected track. 

NOTE: You can also select a single track by double-clicking on it. 

➜ To select multiple tracks: 

Step 1. Click on the first track you want to select.  Hold on down the button. 

Step 2. While holding down the button, draw a box to select additional tracks from the 
map.  Release the button when finished.   

The selected tracks are highlighted. 

Step 3. Go to the TrackPlot menu, and select Intel Update.   

The Intel Update window appears (see Figure 3-3).  The fields are filled with 
default values. 

Step 4. Go to the Map menu, and select Get Selected Tracks. 
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After a few seconds the Intel Update window will be filled with data from the first 
track.  Also, the Previous and Next buttons will become activated.   

You can scroll through the reports using the Previous and Next buttons on the 
toolbar (see Table 3-1). 

3.5 Modifying a Facility or Unit  

You can modify the data on any existing Facility or Unit by using Intel Update.   

➜ To modify a Facility or Unit: 

Step 1. Select the track(s) you want to modify, and open the Intel Update window (see 
3.4, Selecting Tracks, for more information). 

Step 2. Click in the fields you want to modify and type in the new values.   

NOTE: If you are unable to modify a Facility or Unit’s values, then you are working with 
National data.  National data must be copied to your Local View before it can be 
modified.  (See Section 3.9, Modifying National Data to the Local View, for more 
information).   

Step 3. (Optional) Click in the Remarks tab to add text comments for the track.   

If the current record already has comments, the current values will be displayed.  
Add or delete text as necessary. 

Step 4. When you are finished editing the report, go to the File menu, and select Save.  

This saves your modifications  

Step 5. (Optional) If you have multiple reports to edit, click the Next button on the Intel 
Update toolbar (see Table 3-1) to move to the next report.  
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3.6 Deleting a Facility or Unit  

You can delete a Facility or Unit from the Local View using Intel Update.   

➜ To delete a Facility or Unit: 

Step 1. Select the track(s) you want to delete, and open the Intel Update window (see 3.4, 
Selecting Tracks, for more information). 

Step 2. Go to the Edit menu, and select Delete, or click the Delete button on the toolbar 
(see Table 3-1). 

A warning box appears asking if you want to delete the Unit or Facility. 

Step 3. Click OK to delete the Facility or Unit. 

A dialog box appears confirming that the Facility or Unit has been deleted from 
the Local View. 

Step 4. Click OK to close the confirmation dialog box. 

Step 5. (Optional) If you have multiple reports to delete, click the Next button on the 
Intel Update toolbar (see Table 3-1) to move to the next report. 

3.7 Clearing the Map 

Intel Update has an option to clear all currently plotted tracks. 

➜ To clear all tracks plotted on the map: 

Step 1. Go to the TrackPlot menu, and select Intel Update. 

The Intel Update window appears (see Figure 3-3).  

Step 2. Go to the Map menu, and select Clear All. 

All tracks are cleared from the map, and a notification dialog box appears. 

Step 3. Click OK. 



Intel Client User Manual 

3-12  July 1999 

3.8 Modifying Default Values 

Each time you add a new Facility or Unit, the fields on the Intel Update window are filled with 
default values.  If you are entering multiple reports with similar data, you might want to set the 
default values to save time.  After setting the default values, each new Unit or Facility report will 
be pre-filled with values you specified. 

➜ To set new default values: 

Step 1. Go to the TrackPlot menu, and select Intel Update.   

The Intel Update window appears with the current default values (see Figure 3-3). 

Step 2. Select either a Facility or Unit report. 

Step 3. Modify each field to the value you want as a new default. 

Repeat Step 3 until you have modified all of the fields you want to set as defaults. 

Step 4. Go to the File menu, and select Save as Default. 

A dialog box appears confirming that the new default values have been set. 

Step 5. Click OK to close the confirmation dialog box. 

Now each new report opened will automatically contain the default values you specified. 

After setting your own default values, you can always return to the original default values. 

➜ To restore the original default values 

Step 1. Go to the TrackPlot menu, and select Intel Update.   

The Intel Update window appears with the current default values (see Figure 3-3). 

Step 2. Select either a Facility or Unit report. 

Step 3. Go to the File menu, and select Restore Defaults. 

You receive confirmation that original defaults have been restored. 

Step 4. Click OK to close the confirmation dialog box. 
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3.9 Modifying National Data to the Local View 

If your map contains any Facilities or Units that are National data, you will not be able to modify 
them.  To modify National data, you will need to copy the National data to your Local View.  
Once the National Facility or Unit track is copied to your Local View, you will be able to modify 
or delete the track.   

➜ To copy National data to the Local View: 

Step 1. Select the track(s) you want to delete, and open the Intel Update window (see 3.4, 
Selecting Tracks, for more information). 

Step 2. Go to the Edit menu, and select Create Local; or click the Create Local button 
from the toolbar (see Table 3-1). 

A dialog box appears confirming that the selected Facility or Unit has been copied 
to your Local View. 

Step 3. Click OK to close the confirmation dialog box. 

Step 4. (Optional) If you have multiple reports to delete, click the Next button on the 
Intel Update toolbar (see Table 3-1) to move to the next report.  Repeat Step 2 to 
copy the track to the Local View. 

You can now modify or delete the track (see Section 3.5, Modifying a Facility or Unit, or Section 
3.6, Deleting a Facility or Unit). 
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4.1 Introduction to Queries 

A main feature of Intel Client is accessing intelligence data.  The way to access intelligence data 
is through a query.   

A query can be thought of as a question that is sent to an intelligence database.  The answer is 
returned as a text report or as data that is plotted on a map.  For example, a query could ask, 
“How many air field facilities are located in the southern part of France?”  The data would be 
plotted as land tracks on a map of France.  

When querying for intelligence data, you will use categories called Intelligence Functional Areas 
(IFAs).  Each IFA can be viewed as a collection of similar data.  For example, the IFA Air Order 
of Battle (AOB) combines intelligence data such as air fields, bomber units, tanker units, and 
rotary wing units.  When you create a query, you will use IFAs to determine what types of 
intelligence data you want to view by using IFAs. 

Each IFA contains fields.  Fields contain descriptive data about a specific IFA.  For example, a 
query could be created to return all air fields that contain a value of 50% or less in the Percent 
Damaged field. 

The Intel Client offers two different tools to create and run queries:  

• Intel Query (see Section 4.2, Using Intel Query) 

• Land Track Query (see Section 4.3, Using Land Track Query  

Intel Query uses a wizard format to build queries.  You are asked to provide answers to a series 
of questions.  Once you have provided sufficient information, a query will be created.  After 
creation, a query can be saved for later use.  Intel Query has options to refine your queries.  Use 
Intel Query if you want the most flexibility in working with queries. 

Land Track Query tool uses symbols to build queries.  You click on the symbols that represent 
the type of intelligence data you want to view.  Unlike Intel Query, Land Track Query cannot be 
used to save or refine queries.  Use Land Track Query if you want to create queries quickly. 
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4.2 Using Intel Query 

The Intel Query uses wizards to guide you through the creation of a query.  To create a query, 
you answer a series of questions.  Once you have created a query, you can save it for later use.   

4.2.1 Overview of the Intel Query Window 

It is important to be familiar with Intel Query’s features before creating a query.  Most of the 
functions of Intel Query are accessed through one main window (see Figure 4-1). 

➜ To open the Intel Query window: 

• Go to the Track Plot menu, and select Intel Query. 

The main Intel Query window appears (see Figure 4-1). 

IFAs

Menu bar

Query fields,
operators,
and values

Query names

Toolbar

 

Figure 4-1.  Intel Query Window 

4.2.1.1 Menu Bar 

You can access all functions from the menu bar.  Functions include Save, Print, and Help.  You 
can also choose the type of data you will be querying on.   

4.2.1.2 Toolbar 

Like the menu bar, the toolbar provides access to the most commonly used functions.  Toolbar 
functions are accessed by clicking on a button, rather than choosing a menu item.  Some 
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functions, such as Save and Open, are available both through the menu and toolbar.  Other 
functions are only available through either the menu or the toolbar. 

Table 4-1 lists important toolbar buttons. 

Table 4-1.  Intel Query Toolbar 

Icon Name Function 

 
New Creates a blank, new query.   

 
Open Opens a previously saved query.  See 

Section 4.2.7, Loading a Saved Query, for 
more information. 

 
Save Saves a query for later use.  See Section 

4.2.6, Saving a Query, for more 
information. 

 
Delete Deletes a query.  See Section 4.2.8, 

Deleting a Query, for more information. 

 
Run  Runs a selected query.  In most cases, 

running a query will plot tracks on the map.  
See Section 4.2.5, Running a Query, for 
more information. 

 
Draw Box  Limits your query results to a specific area 

on the map.  After clicking this icon, you 
will be able to draw a box on the map.  
Only tracks that are within the box are 
returned by the query. 

 
Draw Circle  Limits your query results to a specific area 

on the map.  After clicking this icon, you 
will be able to draw a circle on the map.  
Only tracks that are within the circle are 
returned by the query. 

 
Draw Polygon  Limits your query results to a specific area 

on the map.  After clicking this icon, you 
will be able to draw a polygon on the map.  
Only tracks that are within the polygon are 
returned by the query. 
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Icon Name Function 

 
Draw Route  Limits your query results to a specific area 

on the map.  After clicking this icon, you 
will be able to draw a route on the map.  
Only tracks that are along the route are 
returned by the query. 

 
Get bounding box  Selects the coordinates of the entire map. 

 
Previous and Next These two buttons allow you to move 

through a list of queries.  Click the up 
arrow to move to the previous query.  Click 
the down arrow to move to the next query. 

 
Help Accesses online help. 

4.2.1.3 IFAs 

The left side of the Intel Query window contains a listing of IFAs.  IFAs are arranged in a “tree 
structure.”  A tree structure means that the list starts out at the root level and branches out to 
more specific IFA categories.  The IFA list expands and shrinks according to the current level of 
detail.   

When a listing can be expanded to more specific IFA categories, there will be a plus (+) in the 
box before it.  Figure 4-2 is an example of the root level IFAs. 

 

Figure 4-2.  Intel Query IFAs 

Figure 4-2 shows the root level IFAs with a plus (+) in the box before each IFA.  The + box can 
be clicked to display more specific IFA categories.  Once a + box is clicked, a list of more 
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specific IFAs is displayed.  The box’s plus sign will be replaced with a minus (-) sign.  Figure 
4-3 shows the branches of the Air Order of Battle (AOB) IFA. 

 

Figure 4-3.  Intel Query Bomber IFAs 

In Figure 4-3, the AOB IFA has been expanded (note the minus sign (-) in the box before it).  
Under the AOB IFA, there are multiple sub-categories.  Each one of the sub-categories can be 
further expanded (note the plus sign (+) in the boxes).  In the above example, the Bomber Units 
IFA has been expanded.  Under the Bomber Units IFA is a listing of specific Bomber Units 
IFAs.  Because there is no box before each of these items, these categories cannot be expanded. 

A complete listing of IFAs is found in the Intel Client Intelligence Functional Area (IFA) 
Reference document, as referenced in Section 1.2, Referenced Documents. 

4.2.1.4 Query Names 

The top right side of the Intel Query window contains the names of all current queries.  When 
there are multiple queries, use the Next and Previous buttons (see Table 4-1) to scroll through 
them.  Intel Query runs all of the current queries listed. 

4.2.1.5 Query Fields, Values, and Operators 

The bottom right side of the Intel Query window contains the fields, values, and operators used 
in the currently highlighted query.  Use the Next and Previous buttons (see Table 4-1) to scroll 
through multiple entries.  As you highlight queries, these values will change.  The values in this 
window can be changed by double-clicking on a value and typing a new value.   
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4.2.2 Creating Simple Queries 

It is important to understand how to effectively structure a query to receive the best possible data 
set.  A good query will return only the data you need.  A poor query might return unneeded data 
that only serves to clutter up the screen. 

When you create a query, you specify what types of data you want returned from the database.  
For example, you could return only Bomber Units.  You can further refine the query by selecting 
values for specific fields.  To refine the Bomber Units query, you could specify that you only 
want to return Bomber Units tracks that have a Combat Effectiveness of greater than 80%.   

The following steps explain how to create a simple query using the wizards in the Intel Query 
tool.  The Intel Query wizards guide you through the process of creating a query.  A simple 
query can be refined to return a more precise set of intelligence data (for information on refining 
a simple query, see Section 4.2.4, Refining a Query). 

➜ To create a simple query: 

Step 1. Go to the TrackPlot menu, and select Intel Query.   

The Intel Query window appears (see Figure 4-4). 

 

Figure 4-4.  Intel Query 

Step 2. Go to the Data View menu, and select the type of intelligence data you want 
returned by the query.   
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The four choices are National View, Current View (default), Observations 
(Tactical data), and Local View Only.  Your selection determines what type of 
data is returned.   

For example, if you chose Tactical data, your query will not include any National 
data tracks (see Section 1.4, Structure of Intelligence Data, for an explanation of 
the types of intelligence data). 

NOTE: The Current View option displays the most recent intelligence data.  If a National track 
also has a corresponding Local record, the Local track is displayed.  If there is no 
corresponding Local record, the National track is displayed. 

Step 3. Click the IFA you want to query on.   

For example, if you were looking for Infrastructure tracks, click on the 
Infrastructure IFA. 

An IFA can contain levels beneath it.  For example, the Infrastructure IFA 
contains levels such as Fuel Facilities and Water Facilities.  

Continue navigating the IFA tree structure until you reach the exact IFA for your 
query.   

Step 4. Right-click the IFA you want to query on.   

A pop-up menu appears. 

Step 5. Select Add to Query from the pop-up menu.   

The first window of the Intel Query wizard appears (see Figure 4-5). 

NOTE: This window will not appear in all cases.  If you do not receive this window, skip to 
step 8. 
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Figure 4-5.  Select Intel Type 

Step 6. Select an intel type: 

• To return Unit tracks, select Units.   

• To return Facility tracks, select Facilities. 

Step 7. Click Next. 

The Field Selection window appears (see Figure 4-6). 
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Fields

 

Figure 4-6.  Field Selection 

 The Field Selection window is used to select the fields to query on.  The fields are 
arranged in a tree structure similar to IFAs.  For example, the top level group Unit 
Also Known As contains fields such as AKA Type, Also Known As, and 
Evaluation.  When a field is selected, a description appears at the bottom of the 
window. 

Step 8. Select the field to query on and click Next.   

The Operator Selection window appears (see Figure 4-7). 
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Figure 4-7.  Operator Selection 

Step 9. Select the operator you want to use in your query.   

The operator is used in relation to a value, which you will supply in Step 11.  For 
example, Matches is one of the operators available to you.  If you chose the 
Percent Damaged field, your query retrieves tracks that “match” a value (for 
more information on operators, see Appendix C, Query Reference). 

Step 10. Click Next.   

The Value Selection window appears (see Figure 4-8). 
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Figure 4-8.  Value Selection 

Step 11. Go to the Value Matches box, and select or type a value.   

NOTE: If you selected the Is Within A List or the Between Two Values operators, then the 
window in Figure 4-8 will be slightly different.  If you selected Is Within A List, you 
will need to select values from a list of permissible values.  If you selected Between 
Two Values, you will need to provide two values. 

You can enter wildcards into the Value Matches box (for information on 
wildcards, see Appendix C, Query Reference). 

The value you enter is used with the field and operator selected in the previous 
steps.  For example, the Bomber Units query with the field of Percent Damaged, 
a Matches operator, and a value of 80 will only return Bomber Unit tracks that 
are 80% damaged.   

A Bomber Units query with the field of Percent Damaged, a Greater Than 
operator, and a value of 75 will only return Bomber Unit tracks that are more than 
75% damaged. 

Step 12. Click Finish. 

Your query now appears in the Name area of the Intel Query window (see Figure 4-1).  You can 
double-click and edit any of the current values and operators.  For example, if you select a value 
of 75 for the Percent Damaged field, you could double-click the value and type in a new one. 
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You can do the following things with your query: 

• Run the query (see Section 4.2.5, Running a Query). 

• Save the query (see Section 4.2.6, Saving a Query).   

• Filter the query by location (see Section 4.2.3, Filter a Query). 

• Refine the query (see Section 4.2.4, Refining a Query). 

4.2.3 Filter a Query by Location 

Once you have created a query, you can filter it by using the location filters.  The location filters 
allow you to limit your query results to a specific area.  For example, if you only want to return 
tracks from the Middle East, you could use the box filter tool to draw a box around the Middle 
East area on the chart, and then run the query.    

Access the location filters from the toolbar on the Intel Query window (see Table 4-1).  The 
instructions below explain how to use each of the location filters. 

➜ To use the box filter: 

• Press and hold the button at the corner of your box search, and draw your box.  
Release the button when finished.   

You receive confirmation of the box’s coordinates. 

➜ To use the circle filter: 

• Press and hold the button at the center of your circle search, and draw your circle.  
Release the button when finished.  

You receive confirmation of the circle’s coordinates. 

➜ To use the polygon filter: 

• Click and release the button at your first corner; move the cursor to the next 
corner, click and release the button.  Repeat this procedure for all corners of the 
polygon.  After the last corner of the polygon has been drawn, double-click the 
corner to end the polygon.  

You receive confirmation of the polygon’s coordinates. 

➜ To use the route filter: 

• Click and release the button at your first point; move the pointer to the next point, 
click and release the button.  Repeat this procedure for all points of the route.  
After the last leg of the route has been drawn, double-click the button to end the 
route.  
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You receive confirmation of the route’s coordinates. 

➜ To use the bounding box filter: 

• Go to the toolbar, and click Get bounding box.   

The entire map’s coordinates are selected. 

4.2.4 Refining a Query 

A simple query contains one IFA, one field, and one value.  Because a simple query only 
contains one IFA, field, and operator, it might not return the exact type of data you are looking 
for.   

A compound query can contain multiple IFAs, fields, and values.  A compound query can be 
more precise compared to a simple query.  For example you could create a query that returns all 
Bomber Units that have an allegiance to Iraq, a combat effectiveness of 100%, and a percent 
damaged of 0%. 

The previous example contains three fields: Allegiance, Combat Effectiveness, and Percent 
Damaged. 

There are three ways to make compound queries:  

• multiple IFAs (see Section 4.2.4.1, Creating Queries with Multiple IFAs) 

• multiple fields (see Section 4.2.4.1, Creating Queries with Multiple Fields) 

• multiple values (see Section 4.2.4.3, Creating Queries with Multiple Values) 

The three ways can be combined as needed.  For example, you can have a query that contains 
both multiple fields and multiple values, or you could have a query with multiple IFAs and 
multiple fields. 
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4.2.4.1 Creating Queries with Multiple IFAs 

You might find that your query needs to return tracks from multiple IFAs.  For example, you 
might need to see both Bomber Units and Air Field Facilities.  Each IFA you add broadens the 
scope of the query. 

Each additional IFA you add to the query contains its own set of fields and values.  Table 4-2 
gives an example of a multiple IFA query. 

Table 4-2.  Sample Multiple IFA Query 

IFA Field Operator Value 

Bomber Units Combat Effectiveness Greater Than 60 

Air Fields Allegiance Matches Iraq 

Table 4-2 shows a query with two IFAs: Bomber Units and Air Fields.  Each IFA has its own 
field, operator, and value.  

➜ To create a query with multiple IFAs 

Step 1. Create or load a simple query.   

For information on creating simple queries, see Section 4.2.2, Creating Simple 
Queries.   

For information on loading queries, see Section 4.2.7, Loading a Saved Query. 

Step 2. Follow steps 2 through 12 in Section 4.2.2, Creating Simple Queries, to add a new 
IFA to the existing query.   

There will now be two IFAs displayed in the Query Names area of the Intel 
Query window (see Figure 4-1).   

Step 3. Repeat Step 2 until you are finished adding IFAs. 

You can do the following things with your query: 

• Run the query (see Section 4.2.5, Running a Query). 

• Save the query (see Section 4.2.6, Saving a Query).   

• Filter the query by location (see Section 4.2.3, Filter a Query by Location). 

• Add additional fields to the query (see Section 4.2.4.2, Creating Queries with 
Multiple Fields). 

• Add additional values to the query (see Section 4.2.4.3, Creating Queries with 
Multiple Values). 
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4.2.4.2 Creating Queries with Multiple Fields 

You might find it useful to create queries that use more than one field.  For example, you could 
create a query that plots all tracks that have an allegiance to China and are more than 50% 
damaged. 

In the above example, the two fields are Allegiance and Percent Damaged.  Only tracks that 
meet both criteria will be plotted.  Each additional field will make your query more precise. 

➜ To create a query with multiple fields: 

Step 1. Create or load a simple query.   

For information on creating simple queries, see Section 4.2.2, Creating Simple 
Queries.   

For information on loading queries, see Section 4.2.7, Loading a Saved Query. 

Step 2. Right-click the query’s current field. 

A pop-up menu appears. 

Step 3. Select New.  

The Field Selection window appears (see Figure 4-9).  

 

Figure 4-9.  Field Selection  
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Step 4. Select a field, and click Next.   

The Operator Selection window appears (see Figure 4-10). 

 

Figure 4-10.  Operator Selection 

Step 5. Select the operator you want to use with the additional field.   

For more information on operators, see Appendix C, Query Reference. 

Step 6. Click Next.   

The Value Selection window appears (see Figure 4-11). 
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Figure 4-11.  Value Selection 

Step 7. Go to the Value Matches box, and select or type a value.   

NOTE: If you selected the Is Within A List or the Between Two Values operators, then the 
window in Figure 4-8 will be slightly different.  If you selected Is Within A List, you 
will need to select values from a list of permissible values.  If you selected Between 
Two Values, you will need to provide two values. 

You can enter wildcards into the Value Matches box.  For information on 
wildcards, see Appendix C, Query Reference. 

Step 8. Click Finish. 

The additional field is now added to the query.  The query can be run (see Section 4.2.5, Running 
a Query), saved (see Section 4.2.6, Saving a Query), or modified. 
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4.2.4.3 Creating Queries with Multiple Values 

Queries can also contain multiple values.  For example, you could create a query that plots all 
tracks that have an allegiance to China or Iran.   

In the above example, there is one field (Allegiance), but there are two values for the field 
(China and Iran). Tracks that meet either value will be plotted.  You can add multiple values to a 
query.  Each value you add will broaden the scope of your query. 

➜ To create a query with multiple values: 

Step 1. Create or load a query.   

For information on creating simple queries, see Section 4.2.2, Creating Simple 
Queries.   

For information on loading queries, see Section 4.2.7, Loading a Saved Query. 

Step 2. Double-click the value you want to add to. 

A cursor appears in the value.  You can now edit the value. 

Step 3. Type additional values for the query. 

Separate each value with a comma. 

Step 4. Repeat Step 3 until you are finished adding values. 

Step 5. Press Enter. 

The additional field is now added to the query.  The query can be run (see Section 
4.2.5, Running a Query), saved (see Section 4.2.6, Saving a Query), or modified. 

4.2.5 Running a Query 

Once you have created a query, you can run it to retrieve data. 

➜ To run a query: 

• Go to the File menu, and choose Run Query; or click Run on the toolbar (see 
Table 4-1).   

A progress box appears, indicating the query is running.   

• If you want to stop the query, click the Stop button. 

• If the query is halted, click the Continue button to continue the query, or click 
Finish to stop running the query.   

Any tracks that meet your query criteria are automatically plotted on the map. 
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4.2.6 Saving a Query 

Once you have created a query, you can save it to use at a later time.  Saving queries is useful if 
you need to run the same query over and over.  Instead of creating the query each time you need 
it, save it once to run multiple times.  

➜ To save a query: 

Step 1. Go to the File menu, and select Save; or click the Save button on the toolbar (see 
Table 4-1).   

If this is the first time saving the query, the Save As window appears.  In all other 
cases, the query will be saved after completing Step 1. 

Step 2. Select the folder you want to save the query in. 

Step 3. Go to the File name box, and type a name for the query. 

Step 4. Click Save.  

The query is saved in the folder you specified.  It can be loaded at a later time and 
run. 

4.2.7 Loading a Saved Query 

Any previously saved query can be loaded.  After a query is loaded, it can be modified or run. 

➜ To load a query: 

Step 1. Go to the File menu, and click Open; or click the Open button on the toolbar (see 
Table 4-1).   

The Open window appears. 

Step 2. Double-click the folder containing the query you want to open. 

Step 3. Click the name of the query. 

Step 4. Click Open. 

The query is loaded.  You will see the current values and fields for the loaded 
query.   

The query can be modified or run.  Follow the steps in Section 4.2.5, Running a 
Query, to run the query. 
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NOTE: If you cannot remember where you saved your query, you can perform a search using 
the Windows Find application.  Look for files that have the .iqy extension, because 
saved queries end in .iqy.  

4.2.8 Deleting a Query 

A query that is not needed anymore can be deleted.   

➜ To delete a query: 

Step 1. Load the query you want to delete (see Section 4.2.7, Loading a Saved Query, for 
more information). 

NOTE: No verification displays to confirm the delete, and there is no undo function, so before 
you complete step 2, double-check that this is the query you wish to delete.   

Step 2. Click the Delete button on the toolbar (see Table 4-1). 

The query is deleted. 

4.2.9 Clearing the Map 

The Intel Query tool has an option to clear all currently plotted tracks. 

➜ To clear all tracks plotted on the map: 

Step 1. Go to the TrackPlot menu, and select Intel Query. 

The Intel Query window appears (see Figure 4-4).  

Step 2. Go to the Map menu, and select Clear All. 

All tracks are cleared from the map, and a notification box appears. 

Step 3. Click OK. 

4.2.10 Plotting Tracks to a Report 

Normally the Intel Query tool returns intelligence data as tracks plotted on your map.  Intel 
Query can also return data in the form of a report.   

➜ To return data as a report: 

Step 1. Create or load a query.   
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For information on creating simple queries, see Section 4.2.2, Creating Simple 
Queries.  For information on loading queries, see Section 4.2.7, Loading a Saved 
Query. 

Step 2. Go to the Output menu, and select Summary.   

Step 3. Run the query (see Section 4.2.5, Running a Query). 

The Intel Summary/Plot Profile window appears.  Each track returned by query 
will be listed. 

Step 4. Double-click the track you want to view a report for. 

An Intelligence Report appears for the track.  The Intelligence Report displays 
detailed information on the selected track. 

4.3 Using Land Track Query  

The Land Track Query tool allows you to query and plot directly to the map using predetermined 
queries, represented by symbols.  The queries are organized into 10 primary types and 28 sub-
types.  Choosing a primary type automatically includes the corresponding sub-types.  More than 
one type/sub-type may be chosen for a query.   

NOTE: The primary types and sub-types used in Land Track Query are similar to, but not the 
same as, the IFAs used in Intel Query.   

You have the capability to limit the query by geographic area using latitude/longitude or military 
grid coordinate systems.  Unlike Intel Query, you cannot save query criteria using Land Track 
Query.   

4.3.1 Overview of the Land Track Query Window 

All of the Land Track Query functions are accessed through one main window.  

➜ To open the Land Track Query window: 

• Go to the TrackPlot menu, and select Land Track Query. 

The Land Track Query window appears (see Figure 4-12). 
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Figure 4-12.  Land Track Query Window 

4.3.1.1 Menu Bar 

You can access functions through the menu bar.  Functions include Run and Help.  You can also 
choose the type of data you will be querying on.   

4.3.1.2 Toolbar 

Like the menu bar, the toolbar provides access to the most commonly used functions.  Toolbar 
functions are accessed by clicking a button rather than choosing a menu item.  Some functions, 
such as Run, are available both through the menu and toolbar.  Other functions are only 
available through either the menu or the toolbar. 

Table 4-1 is a listing of important toolbar icons. 
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Table 4-3.  Land Track Query Toolbar 

Icon Name Function 

 
Run Runs a selected query.  In most cases, 

running a query will plot tracks on the map.  
See Section 4.2.5, Running a Query, for 
more information. 

 
Select All Selects all IFA symbols.   

 
Deselect All Deselects all the IFA symbols.   

 
Select All Units Selects all the Unit IFA symbols. 

 
Select All Facilities Selects all of the Facility IFA symbols.  

 
Draw Box  Limits your query results to a specific area 

on the map.  After clicking this icon, you 
will be able to draw a box on the map.  
Only tracks that are within the box are 
returned by the query. 

 
Draw Circle Limits your query results to a specific area 

on the map.  After clicking this icon, you 
will be able to draw a circle on the map.  
Only tracks that are within the circle are 
returned by the query. 

 
Draw Polygon  Limits your query results to a specific area 

on the map.  After clicking this icon, you 
will be able to draw a polygon on the map.  
Only tracks that are within the polygon are 
returned by the query. 

 
Draw Route Limits your query results to a specific area 

on the map.  After clicking this icon, you 
will be able to draw a route on the map.  
Only tracks that are along the route are 
returned by the query. 

 
Get bounding box Selects the coordinates of the entire map. 
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Icon Name Function 

 
Help Accesses online help 

4.3.1.3 Query Criteria 

The Query Criteria area contains symbols representing predetermined queries. The queries are 
organized into ten primary types and 28 sub-types.  Choosing a primary type automatically 
includes the corresponding sub-types.  More than one type/sub-type may be chosen for a query. 

For example, clicking on the Artillery Order of Battle (ARB) symbol will create a query that 
returns Anti-Aircraft Artillery (AAA) and Field Artillery (FA) tracks. 

The Land Track Query symbols are as follows:  

• ARB (Artillery Order of Battle)  

− AAA (Anti-Aircraft Artillery)  

− FA (Field Artillery)  

• AMP (Amphibious)  

− CLB (Coastal Landing Beaches)  

− HLA (Helicopter Landing Areas)  

• AOB (Air Order of Battle)  

− UNT (Air Units)  

− AFI (Airfield Inventory)  

− SUP (Airfield Support Facility)  

• CHP (Choke Points)  

− CHK (Choke Points)  

− LOC (Lines of Communication)  

− BRG (Bridges)  

− FAC (Transportation Facilities)  

• EOB (Electronic Order of Battle)  

− EW (Early Warning Radar)  

− GCI (Ground Control Intercept)  

− FC (Fire Control Radar)  

− RDR (Special Electronic Devices)  
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• GOB (Ground Order of Battle)  

− UNT (Ground Units)  

− GFI (Ground Force Installations)  

• INS (Military/Non-Military Installations)  

− MIL (Military Installations)  

− MIS (Non-military Installations)  

− URB (Urban Areas)  

• MOB (Missile Order of Battle)  

− SAM (Surface-to-Air Missile Facility)  

− SSM (Surface-to-Surface Missile Facility)  

− SUP (Missile Support Facility)  

• NOB (Naval Order of Battle)  

− UNT (Naval Units)  

− NMI (Naval/Maritime Installations)  

• UTL (Utilities)  

− POL (Petro, Oil, Lubricants Storage and Refineries)  

− PWR (Power Plants)  

− TEL (Telecommunications)  

4.3.1.4 Allegiance Criteria 

The Allegiance Criteria area limits your query to only tracks that belong to a specific allegiance 
(country code).   The Allegiance Criteria area contains a list of countries.  To select an 
allegiance, click on the country you want to return tracks from.   

For example, if you only wanted to see Iraqi tracks, you would select Iraq from the Allegiance 
Criteria list. 
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4.3.1.5 Geographic Criteria 

The Geographic Criteria area limits your query to a specific location on the map.   

You can type coordinates into the location text boxes or enter coordinates using location filters.  
Location filters are the easiest method of entering geographic criteria.  Table 4-3 lists the 
available location filters.  The instructions below explain how to use each of the location filters. 

➜ To use the box filter: 

• Press and hold the button at the corner of your box search, and draw your box.  
Release the button when finished. 

The box’s coordinates are entered into the Geographic Criteria area. 

➜ To use the circle filter: 

• Press and hold the button at the center of your circle search, and draw your circle.  
Release the button when finished. 

The circle’s coordinates are entered into the Geographic Criteria area. 

➜ To use the polygon filter: 

• Click and release the button at your first corner; move the cursor to the next 
corner, click and release the button.  Repeat this procedure for all corners of the 
polygon.  After the last corner of the polygon has been drawn, double-click the 
corner to end the polygon. 

The polygon’s coordinates are entered into the Geographic Criteria area. 

➜ To use the route filter: 

• Click and release the button at your first point; move the pointer to the next point, 
click and release the button.  Repeat this procedure for all points of the route.  
After the last leg of the route has been drawn, double-click the button to end the 
route. 

The route’s coordinates are entered into the Geographic Criteria area. 

➜ To use the bounding box filter: 

• Go to the toolbar, and click Get bounding box.   

The entire map’s coordinates are entered into the Geographic Criteria area. 
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4.3.2 Creating and Running a Query 

➜ To query using Land Track Query: 

Step 1. Go to the TrackPlot menu, and select Land Track Query. 

The Land Track Query window appears (see Figure 4-13).  The window is 
divided into three areas:  Query Criteria, Allegiance Criteria, and Geographic 
Location Criteria.   

 

Figure 4-13.  Land Track Query Window 

Step 2. Go to the Data View menu, and select a data type, either National View,  
Observations, and Current View (Local View). 

The data view determines what type of tracks are returned by your query.  For 
example, selecting National View will only return National data. 

NOTE: The Current View option includes both reviewed Tactical data and National data; 
therefore, it is frequently updated and valuable for querying purposes (see Section 1.4, 
Structure of Intelligence Data, for more information). 
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Step 3. (Optional) Go to the Data View menu, and select the Has Imagery option. 

The Has Imagery option only displays tracks that have associated imagery.  

Step 4. Select the type(s)/sub-type(s) from the Query Criteria area (see Section 4.3.1.3, 
Query Criteria, for more information).   

The default is all subtypes empty.  Clicking a sub-type selects it, filling the 
symbol. 

The toolbar contains four buttons that assist with selecting symbols: Select All, 
Deselect All, Select All Units, and Select All Facilities (see Table 4-3 for more 
information). 

Step 5. (Optional) Select an allegiance (Country Code name) from the Allegiance 
Criteria area. 

Step 6. (Optional) Enter a geographic coordinate into the Geographic Criteria area. 

You can type coordinates into the field entry boxes, or enter them by drawing the 
search area using the location filters (see Section 4.3.1.5, Geographic Criteria, for 
information on using the location filters).   

Step 7. From the File menu, select Run; or click the Run button on the toolbar (see Table 
4-1). 

A Land Track Query Task Monitor window appears, indicating the query is in 
progress.   

• If you want to stop the query, click Stop.   

• If the query is halted, click Resume to continue the query or Finish to stop 
running the query.   

The tracks are plotted automatically during the query. 

4.3.3 Clearing the Map 

The Land Track Query tool has an option to clear all currently plotted tracks. 

➜ To clear all tracks plotted on the map: 

Step 1. Go to the TrackPlot menu, and select Land Track Query. 

The Land Track Query window appears (see Figure 4-13).  

Step 2. Go to the Map menu, and select Land Track Clear All. 

All tracks are cleared from the map, and a notification box appears. 
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Step 3. Click OK. 
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5.1 Viewing Intel Reports 

There are a variety of ways you can view intel reports.  Three reports are available in the Intel 
Client tool.  Each report presents data in a different format.  The following list summarizes the 
reports available: 

• Quick Report – Displays abbreviated data on a single Unit or Facility.  Uses Intel 
Update to display data (see Section 3, Adding and Modifying Intelligence Data, for 
more information on Intel Update). 

• Land Track Report – Displays a complete set of data on a single Unit or Facility.  
Uses a web browser to display data. 

The following sections explain how to view each type of intel report.  

5.1.1 Viewing a Quick Report 

A Quick Report provides you with data on the most important fields for a single Unit or Facility.  
The report uses Intel Update to display data (see Section 3, Adding and Modifying Intelligence 
Data, for more information on Intel Update).  In addition to displaying data, a Quick Report 
allows you to modify the data in a Unit or Facility’s fields.   

➜ To open a Quick Report: 

Step 1. Right-click the track you want from the map or the track plot tree (located to the 
left of the map). 

A pop-up menu appears. 

Step 2. Select Quick Report.  

The Intel Update (Quick Report) window appears (see Figure 5-1).  
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Figure 5-1.  Intel Update (Quick Report) 

5.1.2 Viewing a Land Track Report 

A Land Track Report provides the most detailed information on a Unit or Facility.  The report 
uses a web browser to display data.  The information includes base information, such as the 
name and location.  The Land Track Report will also display any related information, such as 
equipment or facility associations. 

➜ To view a Land Track Report: 

Step 1. Double-click the track you want to view. 

A Quick Report opens for that track (see Section 5.1.1, Viewing a Quick Report). 

Step 2. Go to the Tools menu, and select Display Report; or click the Report button 
from the toolbar. 

Your default web browser launches with a Land Track Report (see Figure 5-2).  
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Figure 5-2.  Land Track Report 

5.2 Filtering Intelligence Data 

The Intel Filters tool allows you to filter the data displayed on your screen.  To create a filter 
profile, you choose which type of tracks you want to display, based upon flag, strength, and 
echelon.  

For example, if you needed to view only Iraqi SAM sites, you could create a filter profile to 
suppress all other tracks on the map. When you apply the filter profile, the current map will only 
display Iraqi SAM sites.  All other tracks will not be visible.  

5.2.1 Overview of the Main Filter Window 

The filter profile functions are accessed through the Intel Filters (Intel Summary/Plot Profile) 
window (see Figure 5-3). 

➜ To open the Intel Filters window: 

• Go to the TrackPlot menu, and select Intel Filters. 

The Intel Filters window appears (see Figure 5-3). 



Intel Client User Manual 

July 1999  5-5 

 

Figure 5-3.  Intel Filters (Intel Summary/Plot Profile) 

5.2.1.1 Menu Bar 

You can access functions through the menu bar.  Functions include Save and Help.  You can 
also choose the type of data you will be querying on.   

5.2.1.2 Toolbar 

Like the menu bar, the toolbar provides access to the most commonly used functions.  Toolbar 
functions are accessed by clicking a button rather than choosing a menu item.   

Table 5-1 is a listing of important toolbar icons. 

Table 5-1.  Intel Filters Toolbar 

Icon Name Function 

 
Delete Deletes the selected track from the Local 

View. 

 
Open Report Opens a Land Track Report for the selected 

track. 

 
Edit Opens Intel Update for the selected track 
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Icon Name Function 

 
Select All Selects all of the tracks from the Tracks 

Summary area of the Intel Filters window. 

 
Deselect All Deselects all of the tracks from the Tracks 

Summary area of the Intel Filters window. 

 
Select All Units Selects all the Unit tracks from the Tracks 

Summary area of the Intel Filters window. 

 
Select All Facilities Selects all of the Facility tracks from the 

Tracks Summary area of the Intel Filters 
window.  

5.2.1.3 Tracks Summary 

The Tracks Summary area of the Intel Filters window lists all tracks that meet your filter 
profile.  The tracks in this area can be edited using Intel Update (see Section 3.5, Modifying a 
Facility or Unit) or viewed using a Land Track Report (see Section 5.1.2, Viewing a Land Track 
Report). 

5.2.1.4 Filter Categories 

The Filter Categories area of the Intel Filters window determines which tracks are displayed 
and which tracks are filtered out. The categories you can filter on are as follows: 

• Flag 

• Strength 

• Echelon 

Each category might contain sub-categories.  You can select individual items, and set their status 
to visible or not visible.  A category is set to visible by selecting the check mark next to the 
category’s box.  A category is set to not visible by clearing the check mark next to the category’s 
box.  

5.2.2 Creating a Filter Profile 

When you create a filter profile, you specify what types of tracks you would like displayed on 
your map.  Before creating a filter track profile, you must have an existing intel track plotted (see 
Section 4, Accessing Intelligence Data, for more information).   

➜ To create a filter profile: 

Step 1. Go to the TrackPlot menu, and select Intel Filters. 
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The Intel Filters main window (see Figure 5-3) appears.  Depending upon what 
type of tracks you have plotted on the map, the window will contain an initial 
filter profile.  You will also see a summary of the tracks currently plotted on the 
map. 

If you want to modify the initial filter profile, go to Step 2. 

If you are satisfied with the initial filter profile, go to Step 3. 

Step 2. If you want to modify the initial filter profile, click on the categories you want to 
modify.  Otherwise, go to Step 3.   

The categories you can filter on are as follows: 

• Flag 

• Strength 

• Echelon 

Each category might contain sub-categories.  You can select individual items, and 
set their status to visible or not visible.  A category is set to visible by selecting 
the check mark next to the category’s box.  A category is set to not visible by 
clearing the check mark next to the category’s box.  

For example, if you wanted to only view tracks with an allegiance of Iran, you 
would go to the Flag box and select the Iran box.  If you want to view all non-
Iranian tracks, you would make sure the Iran check box was cleared (not 
checked). 

As you modify the filter profile, the summary of tracks will change depending 
upon your selections. 

Step 3. If you want to save the summary of tracks, go to the File menu in the Intel Filters 
(see Figure 5-3) main window and select Save As. 

The Save As window appears. 

Step 4. Type the name of your track summary, and click Save.   

The profile is saved as a Microsoft Excel spreadsheet.  The spreadsheet can be 
opened up at a later time or exchanged with other intelligence personnel. 

5.2.3 Modifying Tracks From Intel Filters 

The tracks listed in the in the track summary section of the Intel Filters window (Figure 5-3) can 
be modified.  Before opening the Intel Filters, you must have an existing intel track plotted (see 
Section 4, Accessing Intelligence Data, for more information). 
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➜ To modify tracks: 

Step 1. Go to the TrackPlot menu, and select Intel Filters. 

The Intel Filters main window (see Figure 5-3) appears. 

Step 2. Go to the track summary section of the window, and select the track you want to 
modify. 

The track is highlighted. 

Step 3. Click the Edit button from the Intel Filters toolbar. 

Intel Update appears.  You edit the track using Intel Update (see Section 3, 
Adding and Modifying Intelligence Data). 
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Section 6. Disseminating Data 
  Printing an Intel Track Report, 6-2 
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The Intel Client tool has the ability to disseminate and distribute intelligence data.  You can 
disseminate data by printing hardcopy reports. 

6.1 Printing an Intel Track Report 

➜ To print an Intel Track Report: 

Step 1. Open the Intel Track Report you want to print (see Section 5.1.2, Viewing a Land 
Track Report, for information). 

Step 2. Go to the File menu, and select Print; or click the Print button on the Intel Track 
Report toolbar.   

The Intel Track Report will be printed out on the connected printer. 
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